Introduction

Microsoft® Pocket Outlook® includes Calendar, Tasks, Notes,
Contacts, and Messaging. You can use these programs individually or
together. For example, e-mail address stored in Contacts can be used
to address e-mail messages in Messaging.

Using ActiveSync®, you can synchronise information in Microsoft®
Outlook or Microsoft® Exchange on your desktop computer with your
device. You can also synchronise this information directly with a
Microsoft® Exchange server. Each time you synchronise, ActiveSync®
compares the changes you made on your device and desktop
computer or server and updates both computers with the latest
information. For information on using ActiveSync®, see ActiveSync®
Help on your desktop computer.

Calendar: Scheduling appointments
and meetings

Use Calendar to schedule appointments, meetings and other events.
You can check your appointments in one of several views (Agenda,
Hourly, Daily, Weekly, Monthly, and Yearly) and easily switch views
using the View menu.

snmmod MTwiflss % 4| —— Tap to move one week forward
O Tap to move one week backward

Tap to go to the day’s appointments

—— Tap to display or edit the appointment details

Tap to create a new appointment

Tap to view appointment options

Tap an icon to change the calendar view to
agenda, hourly, daily, weekly, monthly, or yearly

k

hr-ﬁ@ﬂégq i

NOTE You can customise the Calendar display, such as changing the
first day of the week, by tapping Options on the Tools menu.
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Creating appointments

To create an appointment:

1.

If you are in Day or Week view, tap your desired date for the
appointment.

2. Tap New.

/.

| ik

Subrjesct: - Tap to select from a list of predefined subjects
Location: = Tap to select from previously entered locations
Thats: 20/02004 12:00 = Tap to specify the time of appointment
Ereds: 20702104 13:00 =|=— Scroll down to see other appointment options
abpay: Mo | Tap to specify the date of appointment
Oeoxs; CNCE -
Reminder: FEmind me
15 minute(s) | |
Catenorias; Mo cabpogoris, .. = Tap to set the appointment category
Appontment | Notes | Tap to add notes to the appointment
e 1[2[3[4]5[6]7[8]a]0]- =]+
Tabyq|wie|rit|y[ulifo[p[([]
CaPla(sialtla[nljfk[r]:]"]
shift| z|x|e[v[bnjm|,|.[/[+
Ctlaii] " |4 [4]¢]=]+
Edit

Tap to set the appointment reminder options

. Using the input panel, enter a description for the appointment and

the appointment location.

. If needed, tap the date and time to adjust the appointment

schedule.

. Enter other desired information. You will need to hide the input

panel or tap [ to scroll down and see all appointment details.

. To add notes to your appointment, tap the Notes tab. You can

enter text, draw, or create a recording. For more information on
creating notes, see the “Notes: Capturing thoughts and ideas”
later in this chapter.

When done, tap @ to return to Calendar.

NOTE If you select Remind me in an appointment, your device will

remind you according to the options set in 5] > Settings >
Personal tab > Sounds and Notifications.
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Using the summary screen

When you tap an appointment in Calendar, a summary screen appears.
To change the appointment, tap Edit.

- Calendar "?“ s OT:55 @

Fonthly consultation i

12:00-13:00 Fri, 20/08/2004 —— Appointment details
Athans Cafie

Prepare the morthly progress report and sde—— - Notes/additional information
mamore rom Or, Ernesk Ensban on the appointment

| Tap to change the appointment details

edit Toals )

Creating meeting requests

You can use Calendar to set up meetings with users of Microsoft®
Outlook® and mobile phone users. The meeting request will be
created automatically and sent either when you synchronise Inbox or
when you activate the phone.

To create a meeting request:

1. Create an appointment
2. Tap Tools > Options, then

tap the Appointments tab to Options

indicate how you want meeting [2] et remieders For rew tems

requeStS Sent- |15 vl I-I'I'l‘l'll:El:s:l -|-|
Show kons: |_l]_|f&||3|ﬂ|’|ﬁ|
f;;jﬁ";‘jf [ourtiook: E-mal -

General | Appoirtments
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3. If you send and receive e-mail
messages through ActiveSync®,

select OutIOOk E'mail. If you [#] et remirders for new kems

wish to send the meeting [i5 ~| [rirutais) -]
request to mobile phone soweors:  [RIGIHB]A]Z]
contacts, select Text

Messages. vy [oockEval

Jutioo: E-Pa

NOTE You can only send a text
message if your contact
has a mobile phone
number in Contacts.

GiEneral | Appoirkments

To schedule a meeting:

1. Create an appointment.

2. In the appointment details, hide the input panel, then tap
Attendees.

3. From the list of e-mail addresses you have entered in Contacts,
select the meeting attendees.

K
Subject: ! Innwnhg. Keithlyn.. leithlynot..

Liscation: - Drhwu:l. Jobin Fikz... pobn howar..
Tharks; 20,0804 12:00 = []Paz, Aaron Troke ... aarondysh...
Ercs: 20,0804 13:00 = [[Jsantos, Ledesma ... des_santos..,

All G “'.h;l
Cogurs: Onca

Remrder ﬁer'l‘:n'l:l e

i28 1|2 |3[4]|5]|6|7|[B]0]|0]- =]
Sergitivity: Normal Tabjq|wle|[r|t|y[u]i|op|[]]
' caPla|s|drfalhlifk[1]:]"]

Shirt| 2 % | |[¥ |[b|nm|.[.]/]+

apportment | notes | ctfad] " [\ ] [4]t]]+
Edlil |« EH

The meeting notice is created automatically and placed in the
Outbox folder. For more information on sending and receiving
meeting requests, see Calendar Help and Messaging Help on the
device.
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Sending appointments

You can send appointments and other schedules to other devices
using the infrared (IR) and Bluetooth™ capabilities of your Pocket PC.

NOTE Refer to “Chapter 10: Getting connected” for details on
infrared and Bluetooth™ connections.

To send an appointment:

1. Select an appointment you wish to send.
2. Tap and hold the appointment * 2 |calendar V, 4¢ 0258 €

to display 2 pop-up menu.
*nnthly consulk Tlrll.'!rl

3. Select Send via Bluetooth or S e
Beam App(ﬂntment. Send via Bluetooth

. . Mew Appomnl I
4. Follow screen instructions to i
. Cuk
send the appointment. =il
Faske
Delete Appoinbment
Beam Appintment...

Hmrij@@ |-
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Tasks: Keeping a to do list

Use Tasks to keep track or prioritise the things you have to do.

Tap to select the category
of tasks you want to
display

Tap to select a sort order of the task list
Tap to quickly add a new task
Tap to display or edit the task details

L | Tap lsere Lo sdid & new Lask
¥ Activate my PS05 Pocket PCI
Samill s Bluictinkh

Tap and hold a task to display a
pop-up menu of actions

Tap an action for the task

| Tap to create a new task
New Tools 2 B

Creating a task

To create a task:

1. Tap [, then tap Tasks. If Tasks is not listed as an item in the
Start menu, launch it by tapping [ > Programs > Tasks. After
launching, Tasks now appears in the recently used program list.

2. Tap New to display a blank task form.

3. Using the input panel, enter a ! Hvasks Y, 45 1546 @

description.
Friorty-  Mormal

4. Enter a start date and due date, Status: Not Complsted
or enter other information by Starts: hone o
tapping the field first. If the s
input panel is open, you will e |
need to hide it to see all |

Cabegodes: Mo categores... )

available fields.

T, | bloked
5. To assign the task to a ;’;1!]1“"__" 12]g - e .r.'l,'. TlIT
category, tap Categories and CAPlaslaltla[n] i k[1]:] ]
select a category from the list. dulle [l olz [elelnl L}l
On the task list, you can display Edit [

tasks by category.
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6. To add notes, tap the Notes
tab. You can enter text, add a
drawing, or create a recording.
For more information on creating
notes, see “Notes: Capturing
thoughts and ideas” later in this
chapter.

7. Tap @R to return to the task list
when done.

T A% 1K1

Amsd the vsear handbook befors acherabng -
my Pocket P |

Task | bictes |
a1 ]z2]3l4[s5]el7]alalo]-I=]«
Tﬂ:qwnrtruiun[l]

CaPlafsfd[flaln[jfe[t]:]"]
ghift|z [x [c|v[b|nlm|,[. [/]+~
Cla0] " [\ ] [a]r[e]
Edit Tools & 7

4

Activalie my PSOS

Mew Tooks g|a~
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Using the summary screen

Tapping a task on the task list displays a summary screen. To change
the task details, tap Edit.

Activate my PS05 ik

—1— Task details
Start 20)/08,/2004
Do 20)/08/2004

#— Tap to show or hide the task details

Read the user handbook before activating ey L ) )
Packst B, ——— Notes/additional information on the task

Tap to change the task details

Edit Tools B\~

Sending tasks

You can send tasks to other devices using the infrared (IR) and
Bluetooth™ capabilities of your Pocket PC.

NOTE Refer to “Chapter 10: Getting connected” for details on
infrared and Bluetooth™ connections.

To send a task:

1. Select the task you wish to
send.

2. Tap and hold the taskto display

a pop-up menu.
3. Select Send via Bluetooth or ;T:::f“::
Beam Appointment. Sy
4. Follow screen instructions to
send the task.
Hew Tools BE|=
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Notes: Capturing thoughts and ideas

Quickly capture thoughts, reminders, ideas, and phone numbers with
Notes. You can create a written note or a recording. You can also
include a recording in a note. If a note is open when you create the
recording, it will be included in the note as an icon. If the note is
displayed, it will be created as a stand-alone recording.

BLAME w—

|l Folders «

New Tools = |-
|

Tap to change the
sort order of the list

Tap to record

Tap to show or hide the recording toolbar

Tap to create a new note or recording

Creating notes

To create a note:

Tap to save the note and
return to the Notes list

Cnier requirernenits for PSS

I3

1. Tap &, then tap Notes.
1. ¥ersatile and creative .
NOTE If Notes is not listed as g i'l-':‘:'f;';;ﬂ SN
menu, launch it by 5. Eur-lowing!|
tapping f&f] > Programs
> Notes. After
launching, Notes now -
appears in the l_’ecently S 1z[a[a[s[e]7[ala]a]- ]+
used program list. Tala[wle[r[t[y]u]l]o]p|L]]
II?J’-l‘lja’f IJg IIﬂI f Il'a Ilhl Ill Ih [Il ||;.i||l1|—'
. Shift| 2 | | C ¥ | b 5|
2. Tap New to display a blank It ' T L
note. New Edit Tosls &1 7 EL;
3. Create your note by writing, Tap to add a — Tap to show
i i i recording to the or hide the
drawing, typing, or recording. e oout pand
Tap to write on
the screen
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NOTE For more information about using the input panel, writing and
drawing on the screen, and creating recordings, see Chapter 2.

4. Tap €9 when done.

You may change the default Notes options including the writing
mode, template, file storage, and record button action.

To change the Notes options:

1. Tap i, then tap Notes.

2. Tap Tools, then Options... to _
display the options screen. Defauit mode:  [writing ]

) Diefaiit tamplate: [Blank MNota -
3. Make your desired changes.

Save to [0 memory -|
4. Tap @) when done to save your R
changes. TETE N -
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Contacts: Tracking friends and
colleagues

Contacts maintains a list of your friends and colleagues so that you
can easily find the information you look for, whether you are at home
or on the road.

With the mobile phone features of your Pocket PC, you can call your
contact’s home, mobile, or office phone number, send an SMS
message or share the contact information to another device using
the infrared port (IR) or Bluetooth™.

Tap to select the category of
contacts you want to display

AN Contacts - e — L Tap and enter part of a name
to quickly find it on the list

#zb|cde| foh | ik |imn|opa| st juew] =z

Burr, Phil +d4 5566 F THH w

Downing, Eed.  +44 TOOHS4332 w )

Gray, Mesan.. +176679680 ——w—— 1ap an entry to display or
Howeard, Joh.., +4-456667768 w edit the contact details
arcas, Mer.. +EBEIRZZENOTALL W

oz, Aaren Te  -HESOEEGE T w—— Type of contact information

Rickett, Chri... +44332Z210122 W
Gantos, Lede... +44 7000900 w
Yarmg, Emery +EEEIT0ETO0F L1

displayed. Tap to change or select
another contact information.

Hllﬂl'ﬂ'hlm'l'ndl B|=

Tap to sort contacts by name or company

Tap to create a new contact

NOTE To change the way information is displayed in the list, tap
Tools then Options.
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Creating contacts

You can create or add a contact information by:

¢ Using the Contacts application

e Using Microsoft® Outlook on your PC. New contacts will be added
to the P505, the next time it is synchronised with the PC. See
Chapter 3 for details on synchronisation.

¢ Transferring contact information from your SIM card to the
Contacts using the SIM Manager application. See Chapter 5 for

details.

e Receiving a contact information from other devices using beam or

Bluetooth™ features.

To create a contact:

1. Tap &4, then tap Contacts.

2. Tap New to display a blank
contact form.

3. Using the input panel, enter a
name and other contact
information. You will need to
scroll down to see all available
fields.

4. To assign the contact a
category, scroll to and tap
Categories, then select a
category from the list. On the
contact list, you can display the
contacts by category.

- |Contacts

Harme

Joks bt
De=partrmenk:
Dy
Wrork b=t
el I e
Watork sddr
E-rst

Mokl Lsl

Detads [ Notes |

2y 1|2 |3[4(5]|6|7|Bl0|0]-

Te

Tafa[wle[r[t[y[uli[o]p

[]1

CaPlafs d{f]albljlki];]

shirt]z|xlcivibinim], |

17
culaa] - [\ it

ol
[+

-|—|-|

Edit

=&

5. To add notes, tap the Notes tab. You can enter text, draw, or
create a recording. For more information on creating notes, see
“Notes: Capturing thoughts and ideas” later in this chapter.

6. Tap @k to return to the contact list when done.

4-14
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Using the summary screen

Tapping a contact on the contact
list displays a summary screen. To
change the contact information, tap
Edit.

Contact details

Tap to display notes

Tap to change contact information

Phil Burr
Surchasing 3 Logestcs
wodafone LK
Tl L E-nal
=Ty T | Mo |
Edit Tools E|a~

Changing a contact information display

If a contact has multiple contact information (e.g. work telephone,
home telephone, car mobile phone, mobile phone), you can change or
select the contact information displayed on screen.

To change a contact information display:

1. Tap the type of contact
information displayed (last
column of the contact line) to
show additional contact
information.

Al Contacts = [Find & nane

l.:h[ll]-lr I|_4'|| ik |h'|r||||::u| +1 }.:m[r-_rr
Buirr, Phi 4445566 T TSR ]
Doining, Kei,., +44T6R54332 W
Fowi, Brandan  -+8B6Z 34435667 m
w
w
w

Gray, Alesan— -+ 1 THETIEE
Howard, Joh_  +445666TTHE
*arcas, Mervin

& L EEGFFENITEL 4 Wark Tel
N cEREI01 3152 “alsile Tel
M Ein_rarons@ast . F-meail

Mew View Tools E|a~

2. The current displayed contact
information is indicated by a
bullet. Tap another contact
information to change the
contact information display.

ANl Contacts « [Fina & nanne

l.:h[l |J-|.=[ I|_r|| i |h'r||||::|4| +1 f.rﬂ.l[ iyE
Bairr, Phil +445506TTHE w
Doviening, Kel,.. 447654332
Fowd, Brandon  +8BRZ3443566T
Gray, Alesan_  +1 TEETISED
Howeard, Joh_  +445666TTHE

w
L
w
w
w

“arcos, Mervin

= +GRGEIER0TEL 4 Work Tel
H +BEETI01 3152 Saabile Tel
i Ein_arcos@asu — E-meail

Mew View Tools 4 |

Chapter 4: Using Pocket Outlook®

4-15



Getting in touch with your contacts

To call a contact:

1. Tap and hold a contact to
display a pop-up menu. Tap
Call Work/Home/Mobile
to place a call.

x

All Contacks Fined & nanne

'.:tl.l.l.lllrl-h:lhl_ijc |h'nr||::-q| +13 F.rﬁu[ iyE
Baier, Phil +445566TTHE W

Call Horme
Ll Mcbele
Send Email
fld ta Speed Dial,..

SEEEEEES

Beam Contact...
Delete Contact

Send via Bluetooth
#ArcSoft Photo Contacts
Send Text Message

Mew View Tools E|a~

3. Talk to the called party when
connected. The balloon
displays the call duration.

' J [Cantacts £ oz )
Phone - Conmedbed..,

i KT

§

H Duration: 002

] Mlarcos, Meryin

m HESETH0I IS

e ]

Gantos, Lede_  +44 THS0EE0E w
Yamg, Ermamy +HGHA 00T m

Mew View Tools 4 |

2. The phone dials the selected
contact number. Tap Hide to
hide the balloon information
or End to cancel the call.

| Maroos, Mervin

my HEREEHOIEIEE

[Pecke ][]

H o
Santos, Lede_ 44 TES0ESHE w
Y.amy, Ermany +HGEATO0EII0D m

Mew View Tools E|a~

4. Tap End to terminate the
call.
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To send an e-mail message to a contact:

1. Tap and hold a contact, then 2. The Messaging window
tap Send Email from the appears. Compose the e-mail
POp-up menu. message, then tap Send to

send the message.

b4 g [Messaging -:‘ f 736 @
&l Conkacks = Fimd & nane =] | Tor mervin_marcosi@asis . oom, bey
it aby| coke| fgh | i A Send -0 SR *
Barr, Phil +4455667788 w
Call Home :‘
Call Mobile s
Send Email w
Rl Lo Speed Dial... w
L2
Bearn Contack... w
Del=te Contact m
izy 1]2[(3|4|5|6(7[B]0|0]-|=]4
Send via Bhsetooth Tabig[wie[rt|y[uli[o]p[[]]
ArcSaft Photo Contacts WIJJ IJs la |1 Ila Ithli :lt .fll [J; IL'L
Send Test Mos Shiftjz |xcivibinim|.|.]|/]+|
el e cufad] " T\ AL F'._] "
Mew View Tools |- Edit Tools My Test [] 22 EH
NOTES e Refer to Chapter 6 for details on composing and sending

e-mail messages.

e E-mail messaging features are network dependent and
may require subscription to a particular service. Contact
your phone operator for details.
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To send a text message to a contact:

2. The Messaging window
appears. Compose the text
message, then tap Send. The

1. Tap and hold a contact, then
tap Send Text Message
from the pop-up menu.

text message is sent to

contact’s mobile phone.

the

o Messaging -:‘ £ 0737 @
L] | To: 885936013152
Bared |Subj: € ... = ®
|
Call Home T
Call Mobde =
Send Email w
faldl Lo Speed Dial... w
w
Beam Contact... w
Delete Conmtact L]
2y 1|2 |3|4|5]|6|7|Bl0|0]- =]
Seennel wiar Bt it h Tabja|wie|r(t|y[uli[o/p|L]]
ArcSoft Phota Contacts ILC‘-l’ll’lJi |Jg |dff |l'3 IlhlJ_j It II [J |I |
Send Text Mes shift 2 (% [c[v[b[n[m =
ST S e culaa]* [\ LIt
Mewr View Tools E|a~ Edit Tools My Tewst [-] /= EH
NOTES When sending text messages to contacts with multiple

contact information, the Messaging application automatically

selects the mobile phone

number entry.

Refer to Chapter 6 for details on composing and sending text

messages.

To send a contact info by beam or Bluetooth™:

1. Tap and hold the contact you
wish to send, then tap Beam
Contact... or Send via
Bluetooth.

2. Follow screen instructions to
send the contact information.

NOTE Refer to Chapters 10 and
11 for details on sending
information via the IR
port and Bluetooth™.

Al Contacts « [Find & nanne

#ab| code| fon | ik | bon opa| st few] v

Bairr, Phil +44 55667 THE
Dowening, K.,  +44THRG4IIE

. al
Call Wark
Call Haonne
Call Mobile
Send Ernail
Add bo Speed Dial..

Delete Conback

Send via Huetoath
ArcSolt Photo Contacks

Ford, Brandon  +8BERZZ443566T

=]
=
-

EEEY: EEREE

EIM'-I

Sand Text Message

E|*
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Finding a contact

There are three ways to find a contact:

1. In the contact list, tap the T 45 0229
category list (labelled All Show « Find a name
Contacts by default) and select e ey
the type of contact that you SoCategories  JTE6543I2  w
wish to display. To show all Howard, Joh gL 4456667788 w
contacts again, select All Ml | el
Contac_:ts. To view a contact g
not assigned to a category, Yang Emmy  +BB6OT00BIS03  m

select No Categories.

Mew View Tools E|a~
2. To view the names of companies 1412 3
your contacts work for, in the NoCategaries =  [Find a name
contact list, tap View > By #ab[ coe[ fgh [ ik [lon[opa  rst fuew] nz
Company. The number of :ﬁ:ﬂiﬁ:ﬂﬁﬁm
contacts that work for that e e R
company will be displayed to the Tays and Mavelties, Ltd. (1)
. vodafone Strategic Sales (1)
right of the company name. Yook [

Tap the company name to
display the contacts.

= By Campany
Mew | View| Tools B~

3. You can also type the name of

the contact in the Find a S Tintints ~ ' @
name field. When you type a #at] P-ﬂ f ] ik Ihnlrmli;i vl
letter, the Pocket PC Ford Hreesden - Sume ko

automatically searches and
displays the available contacts.
Tap a contact entry from the list
to view the details.

izy 1]2]|al4|5|6|7[B]0|0]- =]
Tabiafwie|[r|t|y|ufl IDIrJlII
CaPlafsa[raln]ilk] |[
S-“'ﬂtJIJ“ f Jvib[n]m{. Jf_l
ctifad] Tele]=
ru-&-rmu
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Adding a photo to a contact

The Photo Contacts application allows you to attach photos to
your contacts. The photo is displayed on screen when the contact
calls you.

To add a photo to a contact:
1. Tap and hold a contact, thentap 2. Tap the Thumbnail View

Arcsoft Photo Contacts button to display a thumbnail
from the pop-up menu. of each contact.
e N 3
Mo Categories = |Find a name Al Conkacks Find & nane
#ib| coke| fgh | i | e ey | it fuvw| w2 #ab|cde| figh | bk [ime [opg| st fuew] vz
Rairr, Phil +445566TTHE w a
Downing, Kel., +44THR54332 w |
Ford, Brandon  +8B6Z34435667  m MoPhote  NoPhoto Mo Proto
. al T S w
Call Work ! w Eaxr, Fhi Downing, E... Ford, Bran...
Call Hioviwie m
Call Mobile T = n
Send Ermail z = HWoPhoto Mo Photo o Photo
dd d Dial.. 8 w
DR A m ey, fle Howaed, 1o, IR
Beam Contact.., .
Delete Contact MoPhoto  MoPhoto Mo Photo
Semd wia Dluetoath I |
Dap, Asroh .. Rickstt, C,, Sanbos, La... |™
Send Text Message |- Mewe View Tools [1] T8

|
Tap to view the contact thumbnail

3. Tap and hold a contact, then 4. Tap Browse... to locate the

tap Attach Photo from the photo you want to attach.
pop-up menu.
N JPhoto Contacts  «F off 0253 @D
All Conkacks = Final & nanme
#ab|coe| figh| ik ime |opa| ret e o
Mo Phata Call Home Tempiate: [none |
Lall *obile : =
Eurr, Fhi S Ermail Ringtons |r|;|.-e |
Semd S5
Mo Photo Sepd MMS
Add bo Speed Dial...
ey, Ao, Ueam Contact...
Dedete Contact
Wo Photo
Attach Mhoto
Paz, ASHON ., i Dt ek Fhetibin
New View Tools | Gave bo SIM [Cok ] [ canesl |
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5. The selected photo is A thumbnail of the attached

displayed. Select a template photo with the contact name
and/or ringtone if you wish to will appear on screen when
customise the contact call the contact calls.

settings. Tap OK when done.

#ab|coz| ﬁ;hl ik i |opal ret

Cowming, .., Ford, Bran.,, G, Ae

Howrd, Jo., —P'G-'!.-Fﬂrm -

 CE e il

—

You can also use Photo Contacts to:

Call and send e-mail/SMS/MMS messages to contacts
Send the contact information by beam

Save the contact information to the SIM card phone book.
Assign a speed dial key to a contact.
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Chapter 5

This chapter provides information on
how to use the Pocket PC phone
features using the Vodafone Menu
and Phone applications.
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Phone features

The P505 is a tri-band mobile phone that allows you to place a call,
send text messages, videos, and audio files to other mobile phones.
You can place a call using the Vodafone Menu or the Windows®
Mobile 2003 Phone applications. The following sections describe the
phone features of your Pocket PC.

Vodafone menu

The Vodafone menu is an interactive application that transforms your
Pocket PC into a mobile phone when you close the phone flip. This
application allows you to enjoy the phone features of your PDA, while
keeping track of the most common PDA functions such as reminders,
appointments, and tasks.

NOTE When the phone flip is open, you can access the Vodafone
menu by tapping the Vodafone logo in the Today screen.

To enable the Vodafone menu:

1. ¢ |settings & Y 4t 0z @
2. Tap Settmgs Vodafone Menu
3. Tap Personal tab. [ Enable
4. Tap the Vodafone Menu icon 8 &l ko
isplay the Vodafone Men
sottngs, e S
5. Tap Enable, then tap @x.

|-
6. Close the phone flip. The screen T IR IR
displays the Vodafone Menu. % @ %
NOTE The touch screen is disabled Contacts  Calendar

when the phone is in @ ﬁ;l
Vodafone Menu mode. @ ' ﬁ
Tasks Cal Log Profils
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7. Open the flip, and now applications
can be selected by tapping on the

Vodafone icons or by tapping on 7

and selecting the application you
require.

" Wadafmnie

2T dfozaa £

B O S

[ contacts  Caends

> @

Tasks Cal Log

O &

Intemet Phore  Medis Player

el €P ¢8

File Marnazger Bhoto aloom Backuo

-|*

Customising the Vodafone menu

To change the Vodafone
menu settings:

2. Tap Settmgs

3. Tap the Vodafone Menu icon .2.

to display the Vodafone Menu
settings.

4. Check the Auto return to home
option to allow the Vodafone Menu
to return to the home screen when
idle for a certain period of time.

5. Check the Auto Keypad Lock
option, then adjust the idle time
before the phone keypad is locked.

6. Tap @k to save your settings.

2 Tdiozaa O

Vodafone FMenu

Enable

-Sattings
Byt retum o home
[] Austo Keypad Lok

frot e [T

Stie: | Customise |

|-

J |settings

2 Tdiozaa O

Yodafone Menu

Enable
-Sattings
[w] Ao retum o home
Busto Keypad Lok
if rat wed for 210 5
10
St [ CustiElg
c ks
1 frin

Hl;
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To change theme, home screen, and animation of

the Vodafone menu:

1. Tap B
2. Tap Settings.

3. Tap the Vodafone Menu icon to display the Vodafone Menu

settings.
4. Tap the Customise button.

5. The Theme tab allows you to select or change the color theme

for the Vodafone Menu
display.

Select a colour from the
available color swatches.

6. Tap the Home Screen tab.
The Home Screen tab allows you
to select a new home screen
background image.

7. Tap Browse to locate the new
background image.

= |'Waoidalnaie M i ?a s F 040 |$
[am s ) B T waEe |

0 AT s

Therre: Seluct
EEETEEEEEN

-l...

= |'Waoidalnaie M i ?& s F 040 |$
TR
. o s I
0 =l _-'=.'.;_I-'.

Tnage: [\windows|ideBackaroundl.g|
| Browse | | twlauit |

Theme | Hore Screen | Animated Home Screen |

Chapter 5: Phone Features

5-5




7. Locate the new home screen 8. Tap the Screensaver tab to

background image, then tap select or change the
the OK button to select. screensaver.

- wodafone Mem 2F T‘ ot 0740 + | Waodafone e T‘ L Bt Y| |:ﬂ
Dpen [am st o B2 '
s AR |
Type: l ichura Fies (bmp;-jog;. oif) -|
Folders
|
fctivesync]
apo]

AppEuttons |
Appiigr ]

Ammu:ﬂ] Plearse chick ore of [ ] Animation

= d
fcmng'ﬁ;rj] theoptorson the [ 5
[CrumpFies] rightt hand side,
4| 0 ¥ DTEHI
ok | Il-m||-u-iu-|n|mnmdmre5nml
El-

Refer to the screens below
for a comparison of
screensaver modes.

Screensaver modes

N Nosal prer =Em "-|'||-l- [ir= B |ﬂ

g |Yodalone e ¢ "-l'||-ll' [iF= B lﬂ g |Yodalone e g "-I'||-II' [iF= B lﬂ

L R =T
l_'| [ UR

sy o WD Ty g Ean sy ) W ED T g Ekin

.:'-.:'-'- : AL LY _'-
] Arunabion %Im ] aewmnabion g HI“Lt! ] Asumabon
G ] (Do || | EE=E e || o= G
Theme | Hoee Soresn | andnshad Horee Soesn Themss | Fowne Soreen | dranshad Homke Soesn Themss | Fowne Soreen | Aranshad Homee Soesn
B B =
Animation Clock Text

9. Tap @R to save your settings. Close the phone flip to see if the
display and screensaver changed based on your settings.
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The Vodafone Menu

The Vodafone Menu contains the phone ISR N= RIS
menu icons that you can select using
the %29 button or the 5-way joystick.

Refer to the table below for the menu
description.

% Messages read text messages (SMS) sent to your PDA

ﬁ:ﬁ Contacts view the SIM and PDA phone book entries

%3 Calendar keep track of your schedules and appointments
‘f%_’:? Tasks keep track of your tasks and to do lists

- Call Log view received, dialled, and missed call information
E.’-‘_lj Profile change the phone profile or turn the phone on or off

The icon bar

Icons at the top of the screen indicate 5 O

phone status as follows:

[l Battery the amount of battery power

& Profile the current phone profile

[E Talking that the phone is in talking mode
? Mute that the phone speaker is mute
E‘! Keylock that the phone keypad is locked
M Missed Call that you have missed a call
Alarm that you have scheduled an alarm
B SMS that you received an SMS message
i Signal the signal strength

¥  Volume phone ring volume level

Chapter 5: Phone Features
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Placing a call

To place a call using the keypad:

1. Close the PDA flip. The Vodafone Vi il 28
Menu appears. L

NOTE If you opened an application
before you close the flip, you
may have to press = (Home) 0934013152
before you place a call.

Contacts

2. Use the keypad to enter the number of the party you wish to call,
then press . The phone dials the number.

3. Wait for the called party to answer. Vi 4l 328
4. Press anytime to end the call. '

rMMarcos, Mervin

NOTE The screen will display the contact name if they are calling
using a number you have saved for them in Contacts or on
your SIM. Likewise, if you have associated a picture/ringtone
with this contact, you will see the picture/hear the ringtone.

To place a call using the Call Log:

1. Close the PDA flip. The Vodafone menu appears. If the flip was
closed, you may have to press (=) (Menu) first.

2. Use %29 to select Call Log < from L Vil Ll %28
the menu, then press (& (Enter). "= Call Log
The screen displays the Call Logs. _Incoming .. |
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3. Use {23 to select from incoming, an Yil 4l 28

[ Clutgoing

outgoing, or missed calls, then press TN o

(Enter). The screen displays the  [&® i [08/23 02:35]
received/dialled/missed call entries. 08 Dowring, Kethiyn ... [D8/21 008

@ Dowrng, Kethhn ... (08720 11:13]

4. Use 225 to highlight the number you
wish to call, then press (Send).
5. Wait for the called party to answer.

6. Press anytime to end the call.

To place a call using Contacts:

1. Close the PDA flip. The Vodafone menu appears. If the flip was
closed, you may have to press (Menu) first.

2. Use &3 to select Contacts % an
from the menu, then press
(Enter). The screen displays the list ~— [MAMAEEIEE
of phone numbers stored in the PDA  |&
Contacts, including a link to the SIM
Phone Book [ 2.

e e

3. Use %9 to select the phone number you want to call, then press

. If the number is stored in your SIM card, select SIM Phone
Book, then press (Enter). The screen displays the phone

numbers stored in the SIM card. Use %29 to select the phone
number you want to call, then press &.

4. Wait for the called party to answer.
5. Press anytime to end the call.

Chapter 5: Phone Features
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Receiving a call

To receive or reject an incoming call:
1. Depending on your settings, the PDA

. . . . Mlanooe, Marvin
rings, vibrates, or rings and vibrates
when it receives an incoming call.

Press © (Accept) to answer the
call or & (Reject) to end the call.
When you accept the call, the screen
shows CONNECTED.

2. Press anytime to end the call.

7 DIE7E9187E9 CONNECTED

To use the call options:

1. After accepting an incoming call,
press = (Options) to display
available call options. Refer to the
table below for the call options.

o G
% DIA78918709 CONNECTED

T

Contacts
Hold Puts the current call on hold
Mute Mutes the current call or a conference call member
Contacts Opens the Contacts menu for dialling additional numbers
Conference* Creates a multi-party conference from two or more callers
Leave* Disconnects a member from the conference call
Drop* Drops a member from the conference call

*Appears only when in conference call mode.

2. Use % to select an option, then press & (OK).

5-10 P505 Pocket PC



Making a conference call

To make a conference call:

1.
2.

Place a call to person A.

After establishing connection with
person A, press (Option), then
use 529 to select Hold from the

menu. Press (OK) to keep the
current call on hold.

. Press (Option), use ¢33 to select

Contacts from the menu.

Select the phone number of person
B, then press @&@.

or

Key-in the phone number of person
B using the keypad, then press &.

. After you have established a

connection with person B, press
(Option), then use 3 to select
Conference from the menu. Press
(OK) to begin the conference.

The screen shows the conference
call members.

o G
i Marcos, Mervin [h"ﬁF['I'I.'[I

Hold

Contacts

I|I rT-.I.I'I s, Ve r\lrnl'lr.lﬂ (i}

e
REsume
Contacts

Wil Al *=z8

' Contacts

FI1| ey I'-!-l.u:li:

':mtact;

i all 328
CONNECTED

7 Conference
L

&% Marcos, MervinCONFERENCED
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To talk privately to a conference call member:

1. During a conference call, use 23 to
select a member you want to drop ey e
from the conference call. Marcos, Meryin CUNFERENCED

2. Press (Option), then select
Drop from the menu.

3. The selected member drops from
the conference call. You can now
talk privately to the remaining
conference call member.

4. To resume the conference, use %3 to select Conference from
the menu, then press & (OK).

To end a conference call:

1. Use %29 to select Conference from the list of members.
2. Press to end the conference call.

5-12 P505 Pocket PC



Viewing SMS messages

The phone alerts you everytime it receives a Short Message Service
(SMS) message from other mobile device. The Vodafone Menu allows
you to view the SMS message.

To view a new SMS message:

1. Press = (Read) when a “You [ O T 4, e
have a new message!!” appears |
on the screen. Press (= (Ignore) to
read the SMS message later. You have a new message!l

2. Read the message, then press &) - (1 Vi 4l %28
(Back) to return to the previous
menu.

1. Use %3 to select Messages i
from the menu, then press (=
(Enter). The screen displays the list
of SMS messages stored in the PDA
and in the SIM memory (2.

2. Use 929 to select the SMS message
you wish to read, then press (&)
(Enter) to display the message.

Messages preceded by EF are unread
messages

3. Press (& (Back) to return to the
previous menu.
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Viewing contacts

The Vodafone Menu allows you to view the contact information
stored in both the PDA memory and SIM memory even when the PDA
flip is closed.

To view your contacts:

1. Put the PDA in idle mode, close the @ Vil all %28
flip, then press = (Menu). 7 Contacts

= cin Phore Book

2. Use & to select Contacts e
from the menu, then press (=
(Enter). The screen displays the list
of phone numbers stored in the PDA
Contacts, including a link to the SIM
Phone Book.

3. Use 9 to select a contact, then CH Yy 4 328
press & (Enter). The screen a / _.C_untg.;i_:rs._.
displays the contact information. il Bt

All the numbers saved for the an Vil il 328
contact will be listed. Icons denote e
the type of contact as follow: o o
@  mobile ; i
office B
%  home
& car
=] pager
B¢  radio
& assistant
NOTE By default, the contact’s mobile phone number is displayed at

the top of the list. If you wish to call the other phone numbers,
use @ to select the number, then press & (Send).
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Viewing appointment schedules

Your appointments stored in the PDA may be viewed using the
Calendar menu.

To view your appointments:

1. Close the PDA flip. The Vodafone Vil Ll 22
menu appears. If the flip was closed, mCalendarlﬂs 08/04]

i Consultatsnn Meak.

you may have to press (=) (Menu)
first.

2. Use 39 to select Calendar &= from

the menu, then press & (Enter).
The screen displays a list of your

future G and past due appointments [E.

3. Use % to select the appointment | _ Vil Al 328

you wish to view, then press (&
(Enter) to view the appointment
details.

4. Press (& (Back) to return to the
previous menu.

5. If you set an appointment reminder,
the screen displays the reminder j{y Remmder
during the specified reminder time. COUSNLNTON MM 1) - SCoar

11:30- 120 26,08 I:I I:'-'||I L.,

6. Press & (Dismiss) to dismiss the B |

appointment and return to the
previous menu.

| Wi Al
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Viewing tasks

The Tasks menu allows you to view the tasks saved in the PDA.

To view tasks:

1.

. Use &3 to select Tasks <2 from the

. bisd 2 amphiecta tasks. then press

Close the PDA flip. The Vodafone
menu appears. If the flip was closed,
you may have to press (=) (Menu)
first.

menu, then press & (Enter). The
screen displays a list of completed

) (Enter) to view the task details.

Press & (Back) to return to the
previous menu.

Viewing call logs

You can view incoming, outgoing, or missed call logs using the
Call Log menu.

To view the call logs:

1.

Close the PDA flip. The Vodafone
menu appears. If the flip was closed,
you may have to press (=) (Menu)
first.

2. Use &3 to select Call Log @+ from
the menu, then press & (Enter).
3. Use ¢29 to select the type of calllog | —r—
you want to view, then press & g g e
(Enter) to display the log. [08/23 10:39]
(08/19 07:47]
4. Press & (Back) to return to the
previous menu.
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Changing the phone profile

The Profile menu allows you to enable or disable the phone flight
mode or change the phone profile.

To open the Profile menu:

1. Close the PDA flip. The Vodafone ax VEFEED

menu appears. If the flip was closed, [P & 10
you may have to press (=) (Menu) Flight Mode S8
first. -
2. Use %9 to select Profiles %@ from
the menu, then press & (Enter).

Ruafilesl

Enabde

Flight Mode

The phone functions are disabled when the Flight Mode is enabled.
Enable this item if you want to use the PDA functions of your Pocket
PC in areas where mobile communication is prohibited (i.e. on an
aircraft).

To enable Flight Mode:

{n Wil <l *=8

1. Use %3 to highlight Flight Mode ( _-'Profile
from the menu, then press () light Modle: =8
(Enable). A check mark appears inside |
the box opposite the option.

2. Press (& (Back) to return to the
previous menu.

Erofilest, b

1Hsahle
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Profile

The Profile option allows you to select from seven preset phone
profiles. Each profile has a unique ring tone, type, and volume
settings for various phone functions such as alarms, reminders, SMS
message, etc.

NOTE The Car, Headset, and Speaker profiles are auto-detected.
For example, the phone profile is set to when you connect a
headset to the device headset port, the phone profile is
automatically set to Headset. You cannot select these
profiles when the PDA is on phone mode.

To select a profile:

1. Use 9 to highlight Profiles from - . Vi Al 28
the menu, then press & (Enter). (@ Fl'ﬂﬁlE

2. Use 533 or the 5-way joystick to R
select a profile then press & (OK).

The bullet preceding the profile is
blacked out.

3. Press = (Back) twice to return to
the Vodafone menu. The icon of the
selected profile now appears on the
icon bar.
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Phone

To use the Microsoft® application for telephony when the flip is open,
tap ], then tap Phone or press the green telephone button below
the screen. This screen will appear.

Signal strength indicator

r L] s =
J Fhone o o 1san 63

Network name

Back button; tap to delete
a dialled number

Tap to open Call History
Keypad Tap to open Speed Dial

Tap to call dialled number

Tap to clear or paste a _|

phone number | | Tap to open the
Contacts menu

Tap to change the Tap to open Notes

phone settings

Placing a call

You can place a call using:

Phone keypad

Call History

Speed Dial

Contacts menu

Voice Commander application

o h i~

Refer to the corresponding sections for details.
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To place a call using the keypad:

1. From the phone keypad, tap
the number of the party you
want to call, then tap Talk.

NOTE Use the correct dialling
prefixes when placing a
long distance or
international call.

If the dialled number is stored
in the Contacts, the display
shows the name of the contact
and type of phone number
being dialled.

The Talk button toggles to
End.

% End

2. Talk to the called party when
connected. The display shows
the duration of the call.

Tap End to terminate the call.
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To place a call using the Call History:

1. Tap the Call History button
to display the incoming,
outgoing and missed call
information.

0934013152 K

2. Tap and hold the entry you wish to

call, then select Call from the AN Calls ~
pop-up menu. The phone dials the m 0911478868 16:56
entry. m 0934013152 16:15

If the number you wish to call is not
in the list selected, tap All Calls, =
then select from Missed, Outgoing,
or Incoming call folders to locate the
phone number entry.

Maring, Lsdesina

HEATITEIHITLE M

¥iew Mote

Dl
Send Tewxt Message
Call

Toaols -l.i..

3. Talk to the called party when
connected. The display shows CE KT
the duration of the call.

_ Santos, Ledesma Val... ¥
Tap End to terminate the call.
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To place a call using Speed Dial:

NOTE

you can use the speed dial feature.

You must assign a speed dial key to a phone number before

1. From the dialer, tap the Speed
Dial button to open the Speed
Dial window.

2. Tap New to display the list of
contacts saved in your PDA.
Tap a number from the list.

'ﬂ!n*“lﬂ

All Contacks =

Finad @ nane

iab| coel fgh | ik | on{opg| et e o

Bairr, Phil

+4455667 THE

Daaning, Kei..,
Downing, Kel...
Downing, Kel...
Downing, Eel...
Downing, Esi...
Ford, Brandon
Gray, Alexan
Howard, Joh.
Hewiard, Jah..
Hiweard, Jalh_
Marins, Mer—
Paz, Baram T...
Paz, Aaron T...
Paz, Baran T...

+44THRSH I3E
4 TRESS 334
+44h555THAD
+IFTENEETE
+OI9 Th5 543
Ry Lk EER LT
+1 ik FaE D
+44 5hE6T THE
+A A4 I T 556
HIFTOEIS THE
+HE6AT401 31 52
+EIMESAGRAT
+RIFESAERAT
_BIAIT44TZHZ

40

Blz=szzvss3rn3=z%(s
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3. The screen displays the 2 |phone & ot 1705 D

contact information. Tap the Speed Dial
Location up/down arrow Contact; Downing, Keithivn Chios
button to assign a speed dial Neme: [Cowring, Feithiyn chioe |
key to the selected contact, Murber: [1347BE5ATH W2 =
then press . Location: [ <Avatadie PG|
NOTE Speed dial key 1 is

reserved for Voice Mail.

You can assign up to 99

speed dial keys.

-.i..

4. The screen shows the speed dial

number and the assigned contact Voice Mail
information.
Dowming, Keithlyn Chioes
+44765654 334 w2
Mew
5. Tap the speed dial number to call. # [ Phone ¢ i 1ras
Otherwise, tap @ to return to the _ KGT
previous menu. DA

Downing, Keithlyn ... »2
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To place a call in Contacts:

1. Tap [, then select Contacts
from the menu. The Contacts
window appears.

2. Tap and hold a contact, then select
Call Work/Home/Mobile
depending on the saved contact
information.

3. Talk to the called party when
connected. The call balloon
shows the duration of the call.

Tap End to terminate the call,
or hide to hide the balloon.

; S ot

5 Today
=) ArtiveSyne
I Calendar
BE Contacts
o Entermeet Euplorer
iy Messaging

wiormation

| Phong

"8 Filr Esplorer .

O Multimedia :
@ Jawbiresker

~ llac :

| J"'HI!I]I'E'I'_I

¥ Gettings

7 Heldp

All Contacts Find & nane

ey coe| fon | ik | e opa| est s oz
Bairr, Phil +445566 T THE W

Call Horme
Call Mobile
Send Email
Aild Lo Speed Dial,..

SEEEEEES

Bearm Contack...
Delete Contact

Senil via Blisebooth
ArcSaft Phato Contacts
Send Test HMessage

Hew View Tools -|a~

~ [Contacts

Phome - Dealing

| Maroes, Mervin
m HESEE 035

Hew View Tools -|a~
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Receiving a call

To receive an incoming call:

1. APhone - Incoming... ; fsaet ¢ 4% zmn
callout appears when you
receive an incoming call while
the PDA is in idle mode.

Tap Answer to accept the
call.

I
173 usbu P
o [Mhisne - [neaming.

2. The Phone window appears.
Talk to the called party.

Tap End to terminate the call.
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Rejecting a call

To reject an incoming call:

1. APhone - Incoming... ; [seant
Ca”OUt appears When you £ 13 sk P

o Mhone - Ine amimng.

receive an incoming call while
the PDA is in idle mode.

Tap Ignore to reject the call.

2. A Phone callout appears telling ; Jseant ! Y ofznaz
you that you have a missed call. e
Tap View to open the Call [ p——
History window and view the ! [Viewe |
missed call information. - Timmaee s

Otherwise, tap Close to ignore
and close the callout.

5-26 P505 Pocket PC



Changing the phone settings

To change the phone settings:

1. From the Phone window, tap 2. The screen displays the Phone
Tools then select Options. settings tab. Change the ring
The phone options window type, ring/keypad tone, and
appears. Personal Identification Number

(PIN) from this window.

Tap @ when finished.

Phone - BIZ65G66ET

Sounds
e
Fung tan=: - |BedCitey ~||][m]
Keypad: |EEE1:| ..|

Security
[#] Rimcuien: PaM wihen phone is ueed

| Change PN |

To change the PIN:

1. From the Phone tab, tap the ;
Change PIN button. The KGT
phone keypad appears. EORAE ey

2. Enter the old PIN using the
phone keypad, then tap Enter.

3. When prompted, enter the new
PIN, then tap Enter to change
the PIN.

NOTE Be careful when
changing your PIN.
Some phone functions
require you to enter the
PIN before using.

Chapter 5: Phone Features 5-27



To activate the phone security:

1. From the Phone tab, check
the item Require PIN when
phone is used. The phone
keypad appears.

2. Enter the PIN using the phone
keypad, then tap Enter.

NOTE When the phone
security is activated,
you need to enter the
correct PIN before using
the phone application.

KGET

To access the phone network services:

1. From the Phone options
window, tap the Services
tab. The window displays the
available network services.

Phuone

Tiy atreas sekbings [or 4 service, select i from
tve Fodowire lst and tap “Get Settings".

Cal Barring

jCalir D

foal Forwarding

o2l Wating

Woice Mal and SMS

| GetSettings.. |

Phore | Servces | Hetwork | rngtone | /4] »
|-

2. Tap a service, then tap the
Get Settings button to get
the network settings for the
selected service.

Phone

Ton acceas sekbings [or 4 servce, select i from
“iGat ;

7] Fesding satbngs From the retwork..

| GetSettings... |

Phore | Servces | Hetwork | rngTone | /4] »
|-
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To change the Call Barring settings:

1. From the Services tab, select

Call Barring, then tap the Get Phane: Call Barring
Settings button. The screen Block incoming calls:
displays the Call Barring | i -
Settlngs Bl ke oouligpavineg alls:
2. Change the Call Barring settings [off i

from this window, then tap @.

The phone sends the new
settings to the network.

B«

To change the Caller ID settings:

1. From the Services tab, select

Caller ID, then tap the Get Phearye: Caller 10
Settings button. The screen Prvide oy caller ID bos
displays the Caller ID settings. E!:{Er:'f’“

2. Change the Caller ID settings
from this window, then tap @.

The phone sends the new
settings to the network.
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To change the Call Forwarding options:

1. From the Services tab, select
Call Forwarding, then tap the
Get Settings button. The
screen displays the Call
Forwarding settings.

2. Adjust the Call Forward settings
from this window, then tap @.

The phone sends the new
settings to the network.

Phaome: Call Forearding

u Forvaard sl incormeng phona cals
Toi | |

Forsard plorss calls arly i
[ urawaiabis | |

[owy: | |
|:| [y s [ |

To change the Call Waiting settings:

1. From the Services tab, select
Call Waiting, then tap the Get
Settings button. The screen
displays the Call Waiting
settings.

2. Change the Call Waiting settings
from this window, then tap .

The phone sends the new
settings to the network.

Phaome: Call Wadting
e cals ane vasbing:
fil ok y me

() o rat notify me

B
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To change the Voice Mail and SMS settings:

1. From the Services tab, select

Voice Mail and SMS, then tap Phare: Vosce Mail ard SM5
the Get Settings button. The M service center: | ITECRRRRTERDS |
screen displays the Voice Malil i) I |

and SMS settings.

2. Key-in the new SMS and Voice
Mail service center using the
soft keyboard, then tap .

The phone sends the new ﬂ‘ﬂjﬂ,ﬂ‘l‘ ﬁ 't"’l Lﬂ',j‘l ,""||§||,; ;'l"]'
settings to the network. CAPla|s a|rialhlyfkfi]:]"]
ghitt[z [x [ c[v[b[n]m].[.[/]+

cufad]“ Tv] [e]e]=]+

=I5

To change the network selection settings:

1. From the phone Settings 2. Select Automatic or Manual
window, tap the Network from the Network selection
tab to display the network option, then tap @.
settings.

Phone
Current network: KGT Current network: KiGT
Praffgrned reetvaorks! Prafigrned retvaorks!
Hetwork selection Hetwork selection
|.l:l.l_||r:l|"|'|a|:'l.' *rl | Selprk | 1-
SLUECET
Phore | Servces | Hevrk | FangTone b Phone | Serces | Network | RingTone | A 4] »
=) e
NOTE It is recommended that you keep the Network selection

to automatic to keep you connected to your phone network.
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To add ring tones in the ring tone selection:

1. From the phone Settings

window, tap the Ring Tone tab Phone
to display available ring tones S e T
you can add to the ring tone list. settings.

2. Select the audio file format G l'lEEl
(*.wav, *.mid, *.wma).from the [Thammiwar 0730/ 24,108
drop-down menu to display all OJalamzway  07/30/2... 7.7
ring tones saved on that format. et 071002, 133

H 5 Cierfailt, OFfanfz., B4a8

3. To Ils:ten to aring tone, sel_ect ED;;JE Spall, bt Al
the ring tone file from the list, R
then tap [»] . Tap [m] to stop. Phone | Services | Netwark | Fngrone [FL4L Y|

4. Tap the box preceding the ring el
tone(s) to select and add the
tone to the ring tone list.

5. Tap the Add button.

6. Tap @ when done.

NOTE Check if the selected ring tone was added to the ring tone list

by tapping the Phone tab from the Services window, then
tap the Ring tone down arrow button to display.
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To enable fixed dialling:

1. From the phone Settings [ fsettogs o wg1na @)

window, tap the FDN Set tab Phone
to display the fixed dial settings. [] Enate Feced Dial Nurber
2. Check the option Enabled Fiued Did List(0/0)
Fixed Dial Number. Mame  [tumber  [loc

Network | RingTore | Foeu et [smsce | (4]
|-

3. When prompted, enter the PIN2 m

using the soft keyboard, then Phone
tap Apply. e oo
4. When you enter the correct Famd
PIN2, you can modify, add, or Neme| P2 | | e
delete an entry in the Fixed Dial [Apply | [Carscel |
List.
5. Tap @When finished. Matwork | RingTore | Fov at [ smsce | [ 4] »
izy 1|2]|al4|5|6|7[B]9]|0]- =]
Tabla[wlelr[t]y[uli[o]p|l[]
CAPla(s|d|f{alh]jlkfi]:]"]|
ghift| 2 [ |c|v|b[nfm|.].[/[+
culad] [\ ] LIt]=
=8
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SMSCB shows information about the cell location in which you are

registered.
To enable the SMSCB:

1. From the phone Settings
window, tap the SMSCB tab to
display the SMSCB settings.

2. Check the option Enable
SMSCB.

3. Select the SMSCB language from
the LANGUAGE list.

4. If you want to accept all SMSCB
channels, check the Accept All
Channels option.

The available channels are
displayed.
5. Tap the APPLY button.

[] Enable sMsCE

; RE II LELETE III-I- _.|..-|

mmilnrqrmlmmlsmissl 4| ¥
H|-

[P ] Coeceve ] (o]

Metwork | RingTore | FoM et | ssce | (4]
E|-
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To create a new SMSCB channel:

1. From the SMSCB window, tap 2. Use the soft keyboard to
NEW. A pop-up window enter the channel name and
appears. number, then tap OK.

Charmal Hama Chanmal Mama

| i |

Chanmel Mumber Chaneel Mumber

§ [ N =

ok | | cancel | [CoE_] [ cancel |
metwork | RingTone | Fon set | smsce [ [4]» Matwork | RirgTone | Fon sat | s | (4]
ey 1(2]3l4|5|6]|7[B]9[0]-|=|4 2y 1|2 [3[4[5|6]7[B[9]|0]. =]
Tabigwle[r|t[y|uli|ojp|[]] Tala[wle[r[t[y[uli[o]p|[[]
CAP[a[s[alr[alnl Tkl ] CaP[a[s[a[r[aln]s k1] ]"]
Shirt|z [x |c|v|b[n|m|.|.[/]+ shirt[z [x [c[v[b[n[m][.[.[/]+
ctlai] " [\ ] [e]t]e[=+ celai] " [\ ] [et]=]+
3. The created channel is

displayed in the SMSCB
window. Tap the box
preceding the channel to
activate.

Erd:-leﬂ‘-!i-‘:B

LN‘-.ISLWSE'EHG.[‘:‘.‘-I .|

[] ccept all channeds

ChannalName |

[##] Crestomer  Lins

[hEw [ DELETE | [MGCIFY |

Metwork | RingTore | FoM et | ssce | [4]

B
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Using other phone applications

The following sections provide information on how to use the
Conference, SIM Manager, and STK applications. You can access
these applications by tapping & > Programs.

w o P F

Gaes Backip Calculator

2 B&Y

Camiera  CapbureFl \ Conlerence,

» B (@

File Explores Fined HI'IJ'IIH
a \9 L—J Terminal e
e multiredin | Services  Comnmander  Media L
MessEnger Ailbunn | Client 4
=) e

Conference call

The Conference call feature of the Pocket PC allows you to talk to up
to five parties simultaneously. The Conference application provides a
graphical conference presentation for easy use.

To start a conference call:

1. Tap L:’.':F > Prog ramS > _' Canderenor
Conference.

2. Tap New Call, then select the way
you want to call the conference
participants.

Refer to the next page for ways on
how to call the conference call
participants.
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When you select:

Dial Number Contacts Call History
A phone keypad appears on The Photo Contacts window The Call History window
the left side of the screen. appears. Tap and hold a appears. Tap and hold an
Tap the phone number of the contact, then select Call entry, then select Call from
participant, then tap #&#to Work/Home/Mobile from the menu.
place the call. the menu.
Rl Cantsis = Al Cally -
_I_mLLI_IEJ_ﬂI_ Ramirez, Shirley B[4
P CE2RAPILZ w i
L L ===
IZZEA0TE1A w
Fowid, I Maroes, H.. I‘"I-.'I:I:I'I. Merdin s
0230 1H152 m
= DZ20000 714 54
o L,
Par, e NN Fhott, T || mﬂm G
2 I ——
| | Santos, Lidtesma.,, 2608 | |
| Sarbas. Le.. ¥ uf +ERSTAEANANA w -
Mo Wi Tusls == Tanls =
When connected, the party 3. Call another conference
becomes the first call participant. When connected,
conference participant. the participant is placed on hold

at the bottom of the screen.

= |Cand ErEnce l'-. & 1m0a l:ﬂ = |Cond Erence I-I s 1o l:ﬁ
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4. Tap and hold the new participant, Y — ¢ wi o ©
then select Join Conference from
the menu.

or

Tap and hold the first conference
call participant, then tap Invite
Participant.

The participant is added to the 2 [canference & 4t oo @
conference.

5. Follow steps 2 to 4 to call additional
conference participants.
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To talk privately to a conference call member:

1. Tap and hold the conference call # [conforonce ¢ dizn @
participant you want to talk with
privately, then select Leave 4 l”u:’_l—r-m”
Conference from the menu. T ——

2. The conference is put on hold, while
the selected member is placed at
the bottom of the screen.

You can now talk privately to the
participant.

3. To bring the participant back to the
conference, tap and hold the icon
then select Join Conference.
Otherwise, select End from the
menu to terminate the conference
call participant.
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To terminate a conference call member:

1. Tap and hold the member you want J [Canforence ¢ w4t nos @
to leave, then select End from the '
menu.

2. The selected member leaves the
conference call. Tap and hold the
remaining member(s) to invite other
participants to the call. gy Srpulis Pt e

® @

To end a conference call:

1. Tap @ from the Conference window. The Phone window appears.
2. Tap End to terminate the conference call.
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